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1  PURPOSE 

The HTML Conversion & Style Guide document along with the accompanying example files serve 
to ease the effort involved in deploying documents to FSA Net. It is intended to be used by 
Federal Student Aid (FSA) Modernization Partners and others who will be delivering documents 
to FSA and will be publishing them on the FSA Net. 

As FSA redesigns its intranet and continues to develop its portal presentations, the emphasis on a 
consistent look and feel delivered over the web increases. Consistency in formatting of content 
increases usability, enhances the user experience, and eases the management of content. This 
document describes how to best prepare deliverables for deployment to the FSA Net. It will touch 
on the steps involved from creating the document through handing the document off to an FSA 
Content Management Representative. 

Specifically, this guide provides: 

• Document formatting conventions 

• Process for converting MS Word documents into HTML consistent with the look and feel 
of FSA Net web sites 

• Frequently Asked Questions regarding the conversion and publishing of deliverable 
documents 

This guide does not provide: 

• Guidelines for developing the user interface for web applications 

• An exhaustive specification of all formatting conventions for deliverable documents that 
will be converted to HTML. As FSA leaves much latitude for the document creators to 
employ formatting that best serves the intent of the document, there is no need to go 
beyond the small number of FSA prescribe style standards. It will be clearly noted when 
FSA standards are prescribed. 

• Methods or procedures for publishing web content to a web server. In the case of FSA 
Net, this is the responsibility of the FSA Content Management Representative. 

There may be project specific document standards that may need to be considered when preparing 
web documents. For example, ITA and CPS developers have web ‘look and feel’ guidelines. This 
document does not supercede these stardards.  

If this document does not provide all necessary information, please contact your FSA Content 
Management Representative. 
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2 HTML CONVERSION PROCESS 

To publish a deliverable document to an FSA Net web site, the document must (1) be created in 
MS Word and prepared for delivery as a print document, (2) be reformatted for the web to 
include FSA standard formatting and other edits necessary for proper rendering of the document 
within a web browser, and (3) be provided to the FSA Content Management Representative. The 
process flow depicted below illustrates the steps in preparing a deliverable document for 
publication to a FSA Net web site. 

Create document
in MS Word for

delivery as a print
document

Reformat
document in MS

Word for web
publication

Publish to web
through FSA

Content
Management

Representative

Divide the
document into

multiple
documents and
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2.1 Create document in MS Word for delivery as a print document 

Using MS Word to create deliverable documents provides the ability to easily convert documents 
for publishing to FSA Net. When creating a deliverable document that will eventually be published 
on an FSA Net web site, there are some basic formatting standards that FSA has established in 
style guides referred to in 2.1.1 FSA Formatting Standards of this guide. Otherwise, clean and 
consistent use of MS Word styles will greatly expedite the conversion of a deliverable print 
document to HTML. 

2.1.1 FSA Formatting Standards 
There are only a few FSA style standards for the use of fonts and graphics in web pages. The 
following describes the text standards that are established in the FSA Style Guide produced by the 
FSA Communications office. 

Print document body text (from 
FSA Style Guide) 

• ITC Giovanni 
• Times New Roman (alternate) 

Web document body text (from FSA 
Web Style Guide) 

• Verdana/Arial/Helvetica/sans serif 
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Text in web graphic element (from 
FSA Web Style Guide) 

• ITC Giovanni 
• Times New Roman (alternate) 

FSA Graphics • Colors, size, and use of specific 
FSA graphics are prescribed in FSA 
style documents described below. 

 

This document is a sample of a deliverable document prepared for print. In the distribution of this 
file are folders containing samples of this document converted to one web page and also 
converted to multiple web pages. 

There are no other FSA standard formatting specifications. So, font size and character attributes, 
such as bold, italics, and underline, are left to the discretion of the document’s author. FSA details 
its standards for the use of graphic elements and fonts within the following two FSA 
Communication publications. 

• FSA Style Guide details the standard use of FSA, ED, and FAFSA graphics and color 
callouts when creating print publications, stationary, and other specialty items such as 
shirts, mugs, or hats 

• FSA Web Style Guide details the standard use of FSA, ED, and FAFSA graphics on web 
pages. It also includes a color conversions chart. 

2.1.2 Use of Styles in MS Word 
When creating a MS Word document deliverable that will be published on a FSA Net web site, 
using certain formatting conventions within MS Word will make the conversion very simple. 
When formatting a document, use the following techniques: 

• Define a style for each header level, body text, bullet lists, table text and any other class of text 
paragraph that will be used within the document. For example, the Normal styles, which is 
used for body text, may be defined with Times New Roman as the font and 11 point as the text 
size. Styles will specify the font, paragraph, tab, paragraph numbering, and other formatting for 
an entire paragraph. Find the styles dialog by selecting Style… under the Format menu. It is not 
necessary to define all styles before creating the document, as styles can be added as needed 
during editing. Modifying a style will update all paragraphs to which the style has been applied 
to reflect the changes made. 

• Apply a style to each paragraphs when creating the document. These styles will format the 
entire paragraph and will translate well to HTML paragraphs styles (e.g. an MS Word “Header 
1” style will translate to an HTML <H1> style tag). Paragraph styles should be applied to text 
within tables or text boxes as well as the body and header text of the document. 
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• Apply character formatting only when the text to be formatted is a substring of a paragraph and 
not an entire paragraph. If character formatting is necessary for an entire paragraph, then a 
paragraph style should be applied or created. Character styles may include font size, bold, 
underline, italics, subscript or superscript among other formatting. 

By employing these techniques, reformatting a deliverable document for publication on the FSA 
Net can be completed by modifying style definitions. There will be no need to reformat each 
individual paragraph within the document. 

2.2 Reformat document in MS Word for web publication 
An MS Word document that will be published to the web will need to be reformatted to properly 
render in a web browser. To reformat a document for publication to a FSA Net web site in MS 
Word; 

• View the document in Web layout mode. This option is found under the View menu. This 
editing view will approximate the look of the document in a web browser. 

• Edit each paragraph style to reflect the FSA formatting standards. Currently, the only FSA 
formatting requirement for web pages is using Verdana, Arial, Helvetica, or a sans serif 
font as the text font. 

• Review the document making sure that it is properly formatted and that the layout is as 
desired. Apply any final layout adjustments or manual formatting necessary. 

• Preview the document in a web browser using the Web Page Preview option under the 
File menu. 

Note that the FSA Net header and navigation bars will be added by the FSA Content Management 
team. They will insert the content provided to them into a template containing the FSA Net look 
and feel. 

2.3 Export document to HTML 
If the document to be published to the web is short enough to load in a web browser over a 
modem connection in a reasonable amount of time, then publish it as one web page. This is 
typically a document that is under 10 pages long and includes a minimal number of graphic 
elements in its layout. 

With a document that will be published as one web page, the process is as simple as saving the 
MS Word document as a Web Page. Specifically, within MS Word, do the following while in any 
editing mode: 

• Selecting Save As… from the File menu. 
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• Give the document a name and select Web Page as the File Type. 

The exported HTML file will be saved at the location specified in the Save As… dialog box.If the 
document contained graphics, they will be placed in a graphics folder at the same location with a 
name that is the same as the HTML page just saved. 

If the MS Word document exported contained a table of contents with links to headers 
throughout the document, this will be saved as links to anchor points within the HTML 
document. This makes navigation easier for the users viewing the document. 

2.4 Divide the document into multiple documents and export to HTML 
When a document is too large or contains too many graphics to be delivered on the web through 
one page, it is best to divide it into multiple documents to avoid inconveniencing users who rely 
on slow internet connections. When dividing a large document, use its logical chapter or section 
breaks as dividing points. Bear in mind that many graphics in a short document may also require 
one document to be divided into multiple documents because graphics can be bandwidth intensive 
and slow down loading in a web browser resulting in a poor user experience. 

After the entire document has been reformatted for web publication, it can be divided by copying 
sections from the one large document and pasting the section into a new, blank document. Then 
save the document as HTML by: 

• Selecting Save As… from the File menu.  

• Give the document a name and select Web Page as the File Type. 

The exported HTML file will be saved at the location specified in the Save As… dialog box.If the 
document contained graphics, they will be placed in a graphics folder at the same location with a 
name that is the same as the HTML page just saved. 

2.5 Link the multiple web pages together through navigation links 
When multiple HTML documents are created by dividing an MS Word document, a mechanism 
for navigating between the HTML pages is necessary. This must be done manually by the 
document author and can be accomplished in several different ways. Consider the following when 
developing a navigation mechanism for your web pages: 

• FSA Net does not deliver content through frames. Navigation between pages should not 
be dependent on the use of frames. 

• A table of contents page that the document author creates is the most useful starting point 
for content that is delivered over multiple HTML pages. This can be created manually in 
any HTML editor. 
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• Pop-up windows can be used if the document is not intended to be read sequentially. 

• Next, Previous, and Top links can be used if the document is to be read sequentially. The 
Next link would take the user to the next HTML page in the sequence of pages, while the 
Previous link would take the user to the previous page. The Top link would take the user 
to a table of contents page with links to all of the HTML pages. 

• Use relative links when inserting the navigation links. These should work when the HTML 
documents are moved to a web server, whereas absolute links will most likely break and 
become inoperative. 

When completed, test all links to make sure they take the user to the proper location. Once the 
web site is published, verify that the links continue to work. 

2.6 Publish to web through FSA Content Management team 
The document creator does not publish content to the FSA Net. Rather, the content is transferred 
to a FSA Content Management Representative who manages the publishing of the content. The 
FSA Content Management team is responsible for inserting the content into a template which 
contains the FSA Net header and side navigation bars which are found on all FSA Net web pages. 
The content is then staged for deployment through the Interwoven tool. 

3 UPDATING WEB CONTENT 

Once content has been published to a FSA Net web site, it can be updated by transferring the new 
content to the FSA Content Management Representative. The process is the same as publishing 
new content otherwise. 

4 FREQUENTLY ASKED QUESTIONS 

4.1 What happens if other HTML editors are used such as MS Frontpage or 
Macromedia Dreamweaver? 

Because MS Word uses specialized style conventions within the HTML pages that it exports, it is 
difficult to edit the content in another HTML editor without running into complications. When 
editing in MS Frontpage, Frontpage will open the document in a MS Word editing window, so 
the MS Word specific style markup is handled well.  

Macromedia Dreamweaver has a Clean Up Word HTML command which strips out the 
specialized MS Word style markup tags. When using this, there are occasions when text will also 
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be inadvertently deleted along with the style tags. Be certain to proofread any document after 
executing this command. 

4.2 What else can this guide be used for? 
This guide serves two purposes. First, it provides a process for formatting content that will be 
deployed on the FSA Net through the FSA Content Management team. It includes the FSA 
formatting conventions. Second, this guide is a generic reference for converting an MS Word 
document into HTML for deployment on any web server, so It can be used for preparing 
documents for delivery in situations other than on FSA Net. 

4.3 How do I add links within an MS Word document? 
There are two types of links that can be added to an MS Word document that will be converted to 
HTML—internal and external. Internal links are hyperlinks that take the user to another location 
in the same document. These are added to a document by selecting Cross Reference… under the 
Insert menu. Then select a heading, a bookmark, a table, or another other location in the 
document that the reference is linked to. Make sure the Insert as hyperlink checkbox is checked. 
This will become an HTML hyperlink when saving the document as a web page. 

An external link will take the user to another document somewhere on the internet or the local 
network. To insert an external link, highlight the text or graphic that will serve as the link and 
select Hyperlink from the Insert menu. Select the document that will be the destination of the 
linked text. An email link can also be added using the same menu command. The email link will 
open the default mail client and create a new message addressed to the person specified in the 
link. 


